
Marcin Kilarski  

Przemysław Kaszubski 

Agnieszka Kiełkiewicz-Janowiak 

WA Stylesheet 1.5.2  
(Updated: 28 March 2022) 

Wydział Anglistyki 

Uniwersytetu im. Adama Mickiewicza w Poznaniu 

http://wa.amu.edu.pl 

 

 

 

 

 

Poznań, 2014-2022 

http://ifa.amu.edu.pl/


WA Stylesheet 1.5.2 (Updated: 28 March 2022) 2 

What’s new in version 1.5.1, 1.5.1a, 1.5.2 ? 

 

 

1. Updated Sections (1.2) and (2)   

The description of the structure of a BA / MA thesis has been updated in compli-

ance with AMU Rector’s regulation 157 of 28 Nov. 2013 (“Zarządzenie Nr 

157/2013/2014 Rektora Uniwersytetu im. Adama Mickiewicza w Poznaniu z dnia 

28 listopada 2013 r. w sprawie zasad składania i archiwizacji prac dyplomowych 

z wykorzystaniem systemu Archiwum Prac Dyplomowych (APD) oraz wzoru 

oświadczenia o samodzielnym napisaniu pracy dyplomowej i zgodności wersji 

elektronicznej pracy dyplomowej z wersją drukowaną”). 

2. Modified reference types  

In version 1.5.1 of the WA Stylesheet the following reference subtypes have been 

added or modified: articles in Internet journals (added notation regarding DOI 

addresses) (17.22 d). 

3. Removed “Oświadczenie” page  

In version 1.5.1a of the WA Stylesheet we have removed the “Oświadczenie” 

page from the list of obligatory parts of the diploma paper. This page contained 

the author’s declaration of authenticity of the work and of the exact match be-

tween its printed form and the electronic version submitted to the APD system; 

the author could also agree for the work to be made available in the AMU Archive 

reading room and / or accessible to other APD users (offering limited protection 

of the author’s and any third parties’ property rights). These declarations and 

agreements are now made electronically inside the APD system when submitting 

the work.   

4. Updated summary lengths  

In version 1.5.2 of the WA Stylesheet we have updated the word sizes of the sum-

maries, as per the latest requirements for MA and BA diploma papers passed in 

November 2021 by the Study Programmes Council (Rada Programowa) published 

on this page: http://wa.amu.edu.pl/wa/pl/dokumenty_wa . 

5. Dedicated WA Template now available for LibreOffice  

Info has been added about a native LibreOffice / OpenOffice version of the WA 

Template, published in March 2022 on the WA Stylesheet download page.    

 

http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://wa.amu.edu.pl/wa/pl/dokumenty_wa
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1. Introduction 

1.1. This Stylesheet is required for all research papers, BA papers, MA theses and PhD 

dissertations written at WA UAM. In the case of research papers, BA papers and 

MA theses no part of the work will be accepted by the supervisor unless it follows 

this Stylesheet. A work which is incompatible with the Stylesheet will be rejected 

by the reviewer. On matters not directly resolved by the current version of the WA 

Stylesheet, please seek your supervisor’s advice. 

1.2. In accordance with the new (as of 1 Jan. 2014) AMU regulations concerning regis-

tration and submission of diploma papers, students are required to submit pdf ver-

sions of their finalized theses via the Archiwum Prac Dyplomowych (APD) web-

site. Any additional files must be zipped together and also submitted to the APD 

system. More specific information for WA students is offered on this page. 

1.3. The description of procedures is based on Microsoft Word 2000/2003. Comparable 

commands are used in other word processors, e.g. Writer in the OpenOffice / Li-

breOffice suite, MS Word 2010 and 2013 with the ribbon menu etc. 

1.4. Authors of BA papers or MA theses may use the BA/MA Template (also called 

“WA Template”). A document template is a type of document that is pre-formatted, 

which means that the user does not have to format the margins, fonts or styles. Word 

processors typically have several built-in templates. To use the WA Template, 

simply download it (http://wa.amu.edu.pl/wa/stylesheet), save it as, e.g., “my_the-

sis”, and start typing in your own text in the fields provided. Please note that as of 

1 Jan. 2014 an updated version 1.5.1 or later of the Template must be used which 

complies with the new AMU regulations concerning registration and submission of 

diploma papers. As of March 2022, a separate template is available for LibreOffice 

/ OpenOffice users. 

1.5. For other guidelines on English academic writing, refer to the PNJA Writing 

Courses site on WA Moodle and the links offered there. 

1.6. As of August 2012, support is provided for the desktop version of EndNote (not 

EndNoteWeb, which does not allow custom styles). EndNote users can visit the 

WA Stylesheet & Template Support site on Moodle SNJL for further information. 

In the Stylesheet document reference types and features supported in the EndNote 

http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://apd.amu.edu.pl/
http://apd.amu.edu.pl/
http://wa.amu.edu.pl/wa/egzaminy_dyplomowe_info
http://wa.amu.edu.pl/wa/stylesheet
http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
http://pracownicy.amu.edu.pl/dokumenty-uam/zarzadzenia-rektora/2013-2014/zarzdzenie-nr-15720132014-rektora-uam-z-dnia-28-listopada-2013
https://lms.amu.edu.pl/snjl/course/view.php?id=144
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custom style are marked with the EndNote logo or “EndNote Users” caption. Note 

that the EndNote software integrates with MS Word only. 

2. Structure of a BA paper / MA thesis 

2.1. The structure of the thesis should follow the general order below: 

 

a) Title page, containing: the student’s first name(s), surname and USOS number (“nu-

mer albumu”); the English title of the thesis and its Polish translation*; the type of 

thesis, type of studies (“kierunek”) and specialization completed (“specjalność”); 

the title, first name(s) and surname of the supervisor (“promotor”); the name of the 

faculty (“Wydział Anglistyki”) and the full name of the university (“Uniwersytet 

im. Adama Mickiewicza w Poznaniu”); the calendar year in which the thesis was 

written and registered;  

(* For theses written in Dutch, the main title should be in Dutch and the translated 

title in English.)  

b) “Summary” page(s), containing an English** summary (“extended abstract”) of the 

work of about up to 400 500 words for a BA paper, or up to 500 750 words for an 

MA thesis;  

c) “Streszczenie” page(s), containing a Polish** summary of the work of about 300 

up to 500 words for a BA paper, or 400 up to 750 words for an MA thesis;  

(** For theses written in Dutch, the Polish “Streszczenie” should precede the Eng-

lish “Summary”.) 

d) “Oświadczenie” – the author’s declaration of authenticity of the work and of the 

exact match between its printed form and the electronic version submitted to the 

APD system; the author may also agree for the work to be made available in the 

AMU Archive reading room and / or accessible to other APD users (offering limited 

protection of the author’s and any third parties’ property rights);  

e) Table of contents and other tables: List of tables, List of figures, List of abbrevia-

tions (if applicable); 

f) Introduction, thesis Chapters, Conclusion; 

g) References; 

h) Appendices (if any). 
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2.2. Both the Table of contents and all the lists may be inserted and updated automati-

cally. In order to add a table, choose Insert > Index and Tables, and then choose 

between Table of Contents and Table of Figures. Note that to enable this feature 

all headings and captions must be defined as such. The tables should conform to the 

requirements for font size and paragraph specified below in sections (4) and (6); the 

style (‘format’) ‘From template’ (‘Z biblioteki’) is preferred among the available 

styles for tables and lists. 

2.3. The word count is based on the Introduction, thesis Chapters and the Conclusion. 

Students should consult their supervisor for the expected number of words in their 

paper/thesis. 

 

(See also http://wa.amu.edu.pl/wa/MA_wymagania.) 

3. Page layout 

3.1. A4 format; margins: 2.5 cm, with an additional margin for binding 1 cm 

3.2. Page numbers appear at the bottom of the page and are right-justified. Pages are to 

be numbered consecutively throughout the work, starting with the title page, but 

without the page number on the title page. 

3.3. No headers may be used. 

4. Font 

4.1. Size 

 

a) for titles of chapters: Times New Roman 16 

b) for the body of the paper, including the table of contents, lists (of figures, etc.), 

section headings, examples and references: Times New Roman 12 

c) for tables and figures (including captions), block quotations and footnotes: Times 

New Roman 10 

 

4.2. Special fonts 

http://wa.amu.edu.pl/wa/MA_wymagania
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See section (11.6) on the use of special fonts with, e.g., phonetic symbols. If necessary, 

Courier, a fixed width font, may be used for, e.g., scripts or concordances, as in the fol-

lowing concordance of the lemma ORGANISM in the BNC Sampler Corpus, formatted 

using Courier 8, with the key expressions marked in bold. If in doubt, please consult your 

supervisor.  

 
 1:    605: me `best" code on which all organisms have converged, or that all existing o 

 2:    640:  like that. The genes in an organism today have come from many different anc 

 3:     93:  rhythm, its effect upon an organism's behaviour, and its ability to adjustt 

 4:   1303: essful ways of constructing organisms it would surely have used those same m 

 5:    601: e last chapter: in existing organisms, proteins never arise except from a de 

 6:    200: tive purposes. Every living organism is thus constrained as a result of sele 

 7:    780: uld expect that many living organisms are successful exponents of chemical w 

 8:    798: more or less harmless micro-organisms, and indeed no organism was found mor  

 

4.3. No other fonts may be used. 

5. Font style and quotation marks 

The following font styles are used: 

 

5.1. Italics 

 

a) for all linguistic examples (morphemes, words, phrases, sentences, etc.), but not 

when representing phrase/sentence structure (for examples see the WA Template) 

b) in titles (or abbreviations of titles) of: literary works (novels, collections of short 

stories, poetry volumes, etc.), dictionaries, encyclopedias, names of journals and 

periodicals (incl. internet journals), books (monographs, edited works, also in the 

e-book format), works of art, titles of web sites and blogs (but not individual web 

pages or entries), titles of computer programs and databases, titles of films and mu-

sic albums (but not individual songs or tracks) 

c) for emphasis in quoted text (as in (8.4) below) and to highlight a particular term, 

e.g. “I would like now to distinguish between the use of the terms code-switching 

and code-mixing.” 

d) Italics should not be used for common loanwords, e.g. “ad hoc”, “vice versa”, 

“Sprachgefühl”. 
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5.2. Bold 

 

a) in chapter titles and section headings 

b) to emphasize a part of an example  

 

 

5.3. Small capitals 

 

a) Small capitals are used in numbered examples for abbreviated grammatical catego-

ries in a word-for-word or a morpheme-by-morpheme gloss (see example (4) be-

low). 

b) Small capitals may also be used to refer to conceptual metaphors and image sche-

mas in cognitive linguistics, e.g. LOVE IS JOURNEY, and for headwords of dictionary 

entries. 

 

5.4. Superscript may only be used for footnote numbers and symbols such as “x2” (none 

for “th”, “nd” in ordinal numbers). 

5.5. Underlining may not be used in the text. 

5.6. Double quotation marks are used in quotations (8.1), in References (see (16) and 

(17)),  

5.7. Single quotation marks are used in quotations within quotations (8.4), translation 

of examples (11.3), in References (16.7). In addition, single quotation marks may 

be used when the author wishes to distance himself/herself from the conventional 

meaning of a word or phrase in order to project an attitude, typically irony or sar-

casm, e.g. “Everybody is a ‘slave’ to something.”. 

 

(Note: Avoid the use of single quotation marks to invoke a terminological use of a (com-

mon) word or phrase, e.g. *“The term ‘English phonetics’ refers to the description of the 

sounds encountered in English as a world-wide language.” Terminological senses may 

already be captured as special instances of quoting from a source (in which double quo-

tation marks and citations may apply), e.g.: 
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… students and teachers in the “periphery” (Canagarajah 1993, 1999) are known to resist 

English teaching methods. 

 

In yet other situations, terminological uses might be regarded as a type of emphasis, hence 

resolved with italics, cf. 5.1 c). 

6. Paragraph 

6.1. Indentation 

 

The first line after a chapter title and a section heading should not be indented. Otherwise 

all subsequent paragraphs should be indented by 1.25 cm. The tab key (not the space bar) 

should be used to indent paragraphs; in the WA Template, the “IFA body text indent” 

style should be applied instead. 

 

6.2. Line spacing 

 

a) 1.5 for the body of the paper, table of contents, lists (of figures, etc.), examples and 

references 

b) 1 (single) for tables, block quotations and footnotes 

 

Line spacing is pre-formatted in the WA Template as “exactly 21 pt” for the body of the 

paper, table of contents, lists (of figures, etc.), examples and references, and as “exactly 

12 pt” for tables, block quotations and footnotes. 

 

6.3. Numbered examples should be preceded and followed by a single blank line (note 

that examples which appear in lists are not separated by blank lines). 

 

6.4. Alignment 

 

All paragraphs are left- and right-justified, except for the References list, which should 

be left-justified. 
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7. Titles and headings 

The thesis should be divided into chapters and sections with appropriate titles and head-

ings respectively. Each chapter should begin on a new page. 

 

7.1. Capitalization 

 

Only the first word of the title or heading should be capitalized. In addition, capitals may 

only be used in words which are normally capitalized, e.g. proper nouns. 

 

7.2. Punctuation 

 

No full stop should be used following a title or a heading. 

 

7.3. Chapter titles 

 

Chapter titles should be formatted in bold type, Times New Roman font size 16. The 

spacing before and after a chapter title is pre-formatted in the WA Template (the space 

between the top margin and the chapter title should be set to 138 points, with a space of 

44 points between the title and the main text). The chapter number and title appear in a 

single centred (not left-justified) line, with the number followed by a colon, e.g. 

 

Chapter 1: Basic strategies in saving your sanity 

 

7.4. Section headings  

 

Headings should be numbered and formatted with appropriate heading styles (starting 

flush left, with bold type and Times New Roman font size 12), e.g.  

 

1.1. Section heading 

 

1.1.1. Subsection heading 

 

1.1.1.1. Subsection heading 
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The maximum of four levels of numbering may be used, as in “1.1.1.1”. In justified cases 

other types of numbering may be used, for example lowercase letter numbering. Section 

headings should be preceded by two blank lines and followed by a single blank line. Sec-

tion headings are pre-formatted in the WA Template. 

Care should be taken to avoid widowed headings, i.e. headings which appear at 

the bottom of a page and are separated from the text of the following paragraph (widowed 

headings will not appear if proper headings styles are used). 

8. Quotations 

This section describes the formatting standards for quoting. Please note that quoting, es-

pecially from critical and secondary sources, is a citing technique which is often abused 

by students. Direct and indirect quotations should mainly be used to highlight and elabo-

rate on the precise wording or content of a definition, statement etc., and accompanied by 

commentary. In order to integrate others’ ideas into your argument, you should first con-

sider paraphrasing, summarizing and generalizing / synthesizing information from multi-

ple sources, as these techniques are more efficient and usually more ethical forms of 

source use (cf. section (9)). 

Note the difference between a “quotation” and a “citation” (see section (9)). A ci-

tation is a formal acknowledgement to a source used, or “cited”, in one’s text, whether 

that source is quoted, summarized, paraphrased or simply pointed to. 

Note the formal difference between a short (up to 50 words) quotation included in 

the text (a run-on quotation) and a longer quotation formatted separately (a block quota-

tion). 
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8.1. Run-on quotations 

 

Run-on quotations appear in double quotation marks. The closing quotation mark should 

follow the punctuation mark (usually a full stop) only if the text quoted is a statement and 

ends the sentence, e.g.: 

 

According to Dixon (1979: 63), “[m]any languages which have an ergative morphology 

do not have ergative syntax.” 

 

If the text quoted is immediately followed by a non-integral citation, the final punctuation 

mark should come after the citation, e.g.: 

 

“The process might be called an adoption, for a speaker does adopt elements from a sec-

ond language into his own” (Haugen 1950: 211).  

 

The punctuation mark should follow the closing quotation mark if the text quoted is a 

term or a short phrase rather than a statement, e.g.: 

 

This relationship is captured by Canagarajah’s (1993, 1999) concept of “periphery”. 

 

The punctuation mark (usually a comma) should follow the closing quotation mark, if the 

text quoted is followed by another part of the sentence, e.g.: 

 

Contrary to Dixon’s (1979: 63) observation that “[m]any languages which have an erga-

tive morphology do not have ergative syntax”, several contemporary studies challenge 

this assumption. 

 

Both the opening and closing quotation mark should be raised, following the Eng-

lish convention (i.e. “ABC” and not „ABC”). 

In run-on quotations containing two (or possibly more) lines of verse, the ends of 

lines should be indicated by a slash sign surrounded by single spaces (“ / ”), e.g.:  
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… the Chorus of the Witches echoes, “Round, around, around, about, about / All ill come 

running in, all good keep out”. 

 

If you need to quote several (three or more) verses of poetry, it may be advisable to apply 

a block quotation retaining the original versification: follow your supervisor’s recommen-

dation.  

 

8.2. Block quotations 

 

Block quotations are used when the quoted material exceeds 50 words (for literary quo-

tations, follow also your supervisor’s advice). No quotation marks may be used. The 

quoted text should be formatted as follows: 

 

a) indentation of the paragraph: 1.25 cm on both the left and the right side, with the 

first line starting flush left (i.e. not indented) 

b) font: Times New Roman font size 10 

c) line spacing: single 

 

The quotation should be preceded and followed by a single blank line (Times New Roman 

12). The citation follows the original text (including any full stop after the last sentence 

or possible ellipsis). The font and paragraph style of a block quotation are pre-formatted 

in the WA Template. Example: 

 
Any account of meaning in language must (a) be faithful to the facts as we observe them, 

and (b) must be as simple and generalizable as possible. If we approach meaning entirely 

from a pragmatic point of view, or entirely from a semantic point of view, these require-

ments are not met; however, if we approach meaning from a point of view which com-

bines semantics and pragmatics, the result can be a satisfactory explanation in terms of 

these two criteria. (Leech 1983: 7) 

 

The text that immediately follows a long quotation usually carries commentary and is 

thus unlikely to be indented, since quotations should rather not be used to conclude para-

graphs. It is also common practice, especially in literary essays, to introduce longer quo-

tations with a leading sentence ending with a colon. 

In the unlikely event that more than one paragraph must be quoted in a block 

quotation, it is recommended that consecutive paragraphs be separated as in the original 
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text (typically an extra indentation or a wider line space of 1.5). Consistency in the once 

established format is required. 

Block quotations from poems, plays or dialogues composed of multiple lines of 

text should retain the original division into lines, otherwise following the general font and 

line-spacing recommendation for block quotations. 

On the formatting of linguistic examples, see section (11). 

 

8.3. Translation 

 

a) If the quoted text is in a language other than English, a translation should be pro-

vided in square brackets following the original. If the text is translated by the author 

of the work, this should be indicated by “[translation mine, AB]”, where “AB” 

stands for the author’s initials. 

b) If all the translations in the text are made by the author of the work, this may be 

indicated only once by “All the translations from Polish sources are mine, AB” in 

a footnote after the first translation. 

c) In BA papers and MA theses the English translation may be provided without the 

original; this should be indicated only once by “All the translations from Polish 

sources are mine, AB” in a footnote after the first translation. 

d) The translation of a block quotation should be placed following the quotation, be-

ginning flush left on a new line, in the same format as the quotation. The translation 

should be enclosed within square brackets. 

 

8.4. Additions, omissions and changes in the quoted text 

 

a) Additions by the author of the work within or after the quotation should be placed 

within square brackets, e.g. when a part of the quoted text is emphasized, this should 

be indicated by “[emphasis mine, AB]”, where “AB” stands for the author’s initials. 

b) Omissions by the author should be indicated by ellipsis points with brackets, e.g. 

“formal properties of utterances which are determined by (…) knowing certain as-

pects of the communication act”. 

c) When the quoted sentence becomes part of the text, capitalization of the first letter 

of the original sentence should be adapted within square brackets: 
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According to Dixon (1979: 63), “[m]any languages which have an ergative morphology 

do not have ergative syntax.” 

 

d) Anything quoted within should be placed in single quotation marks.  

e) Any other changes introduced to the quoted text MUST be acknowledged, e.g. 

 

“The classificatory verbs are sensitive to certain physical characteristics of their semantic 

themes [emphasis mine, AB]” (Scancarelli 2005: 376). 

 

The square brackets with the acknowledgement should be placed immediately after the 

excerpt they refer to. Emphasis encountered in the original text may be noted using “[em-

phasis in the original, AB]”, placed immediately after the emphasized item. 

 

f) Mistakes in the source text must be reproduced and indicated by “[sic]” directly 

following the mistake.  

9. Citations 

(EndNote users: Refer to the guides on the WA Stylesheet & Template Support site on 

Moodle for information on how best to insert and format various citation types with the 

program.) 

 

9.1. Citations (or ‘in-text citations’) are used to refer the reader to the full information 

about another work which the author quotes from or paraphrases. This is why de-

tails such as the title of an article or a book, the publisher and the place of publica-

tion are only given at the end of the thesis in the References. The general citing 

standard adopted in the WA Stylesheet is the “author-year” standard (as opposed to 

footnoting or numbering, used in some other stylesheets). 

9.2. Notice the different types of citations used for quoting, paraphrasing and referring: 

 

a) quoting 
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(Note: As cautioned in section 8 above, quoting is often abused by students and care 

should be taken not to overquote sources.) 

 

Direct quotations: 

 

According to Humbley (2002: 114), “English speakers typically perceive French speakers 

as stressing the final syllable of a word.” 

It appears that “ongoing linguistic changes may often be reflected in unusual patterns of 

social class differentiation” (Chambers and Trudgill 1980: 95). 

 

In the first example, the cited author’s name constitutes a part of the writer’s sentence; 

such citations are called “integral citations”. In the second example, the citation is de-

ferred and placed entirely in parentheses as a referring label; this type of citation is called 

“non-integral”. This distinction pertains to all forms of source use, not only quoting. The 

choice between the two forms of citing is not free: whereas integral citations tend to un-

derscore the authority of the researcher(s) being cited, and may thus be a desirable form 

of citing for non-expert writers (also because it is easier to integrate such external infor-

mation with one’s own ideas), non-integral citations are less conspicuous allowing the 

writer and the reader to focus directly on the reported statement or data and to (almost) 

ignore the cited name. Special care should be taken to use non-integral citations unam-

biguously (see 9.2c). 

In a citation, the author’s name should be given together with the year and the 

page details (if applicable) rather than separately. Practice such as the following, or sim-

ilar, is discouraged: 

 

*According to Humbley, “English speakers typically perceive French speakers as stress-

ing the final syllable of a word” (2002: 114). 

 

(See also (9.17 d) on multiple citations to one source within a paragraph.)  

 

 

Indirect quotations: 
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If, for some reason, it is impossible to get to the original quotation and the author wishes 

to quote it indirectly from another source, this should be indicated in the citation by “as 

quoted in”, as in the example below. Both the original and the secondary source should 

appear in the References. Such quoting should be reduced to a minimum. 

 

“[M]en speak vernacular more frequently, more consistently, and more genuinely than 

women” (Orton 1962: 15, as quoted in Talbot 1998: 21). 

 

Quotations from works of literature should be followed by, in the case of prose 

works, the (abbreviated) title and page number(s), e.g. “(WH, 125-126)”; in the case of 

poems, the (abbreviated) title and the line number(s), e.g. “(“Konkurs”, 40)” ; and, in the 

case of plays, the (abbreviated) title and the numbers of the act, scene and lines (if appli-

cable), e.g. “(Temp., 4.1.123-127)”. The full title of a literary work, i.e., Wuthering 

Heights, “Konkurs piękności męskiej”, The Tempest, should be given on first mention 

(see also (10.2), (12.2)).  

 

b) paraphrasing  

 

Direct paraphrasing: 

 

Givón (1979: 209) distinguishes the following phases of grammaticalization … 

 

Indirect paraphrasing: 

 

If, for some reason, it is impossible to get to the original source and the author is only 

able to refer to a mention of it in a later source, this should be indicated by “([original 

source], as cited in [later source])”, as in the example below. 

 

According to Stielau (1980, as cited in Heath 1984: 375), … 

 

Note that both the original and the later source should appear in the References. 

 

c) referring 
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this aspect has been described in, e.g., Humbley (2002: 121-122) 

only a brief overview will be given here (see also Humbley 2002: 120) 

 

It is important to avoid attaching single non-integral citations ambiguously to general 

statements or to longer, complex arguments. In the example below it is impossible to 

determine whether Clement (1993) was the author of the reported idea or one of the in-

vestigators of the causes of illiteracy: 

 

*The causes of illiteracy had been widely investigated (Clement 1993). 

 

The following examples, depending on the writer’s intention, do away with the ambigu-

ity: 

 

The causes of illiteracy had been widely investigated, as was noted by Clement (1993). 

The causes of illiteracy had been widely investigated (e.g. Ferrara 1990; Hyon 1994; 

Jones 1987). 

 

Ambiguous citations should also be avoided at ends of paragraphs which combine the 

ideas of the thesis author with those borrowed from reported sources, e.g.:  

 

*Fast speech is always connected. In addition, it is also natural, though it may be read or 

prepared beforehand (Sobkowiak 2001: 269). 

 

The non-integral citation above does not indicate precisely which information has been 

drawn from the source: 1) that stated in both preceding sentences, 2) that given in the last 

sentence, or 3) that offered in the final concessive comment. Such ineffective citing 

should be corrected and perhaps converted into the integral format. Assuming that the 

first sentence communicates an obvious fact in no need of support, the cited source could 

be integrated into the second sentence thus:  

 

Fast speech is always connected. In addition, as Sobkowiak (2001: 269) notes, it is also 

natural, though it may be read or prepared beforehand. 
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9.3. Global citations, i.e. citations without references to specific page(s), as in “Linguis-

tic encyclopedias include, e.g., Bright (1992) …” should be used sparingly, prefer-

ably when reference is made to the work as a whole, rather than to particular views 

or arguments, etc. 

9.4. When tables, figures or diagrams are taken or adapted from another source, this 

should be indicated by either “after” or “adapted from”, respectively, e.g. “in Table 

1 (after Corbett 2000b: 189)”, “in Table 1 (adapted from Corbett 2000b: 189)”. 

9.5. First names or initials should not be used in the citation unless it is necessary to 

distinguish between two authors with the same surname, e.g. “According to J. M. 

Anderson (1973: 20), …”. 

9.6. If a publication has more than two authors, the surname of the first author should 

be used, followed by “et al.” (without a comma preceding and with a full-stop fol-

lowing). The names of all the authors should be given in the References.  

9.7. When more than one work is listed in the References for an author and the same 

year, the works should be distinguished by small roman letters (a, b, c, etc.), e.g. 

“see also Clyne (1987a, 1987b)”. The same roman letter should be appended to the 

publication year in the References (cf. the listing in (18)). For publications with 

more than two authors which appeared in the same year and have the same first 

author (or the same initial authors) but different other authors, the citation should 

include as many surnames as necessary to make it unambiguous. In such cases ro-

man letters a, b, etc. are not appended to the publication year. Example:  

 

“(Petrides and Pérez-González et al. 2007; Petrides and Pita et al. 2007)” 

 

(EndNote users: Refer to the guides on the WA Stylesheet & Template Support site 

on Moodle for information on how to manually adjust such cases.) 

 

9.8. In citations the surnames with particles (such as “de”, “van”, “von”) should be spelt 

out depending on the way they are listed in the References. Thus, if listed as “Hum-

boldt, Wilhelm von. 1827.”, the citation form will be “(Humboldt 1927)”; if listed 

as “Van Dijk, Teun. 1993.”, the citation will be “(Van Dijk 1993)”. 
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9.9. Citations of anonymous works are given with the title of the work and the edition 

date, e.g. “(Sir Gawain and the Green Knight [n.d.] 1972)”, “(WebCorp Live 

2011)”, “(“Hillary Rodham Clinton” 2011b)”. 

9.10. When referring for the first time to a recent edition of a literary work of the past, 

the year of the original publication (if known) should be given in square brackets, 

followed by the year of the edition used, e.g. “Shakespeare ([1623] 1999)”. The 

same pattern should be used in the relevant bibliographic entry in the References. 

In the subsequent citations to the same work the date of the edition should be used, 

i.e. “Shakespeare (1999)” (in the case of integral citing). Note, however, that in 

historical reviews of literary periods references should be made to the original pub-

lications and their dates, rather than to recent editions. 

9.11. When referring to a subsequent edition of a (non-literary) work, the year of the first 

publication (if known) may also be indicated for the sake of accuracy. It should then 

be given in square brackets, followed by the year of the edition used, e.g. “(Hudson 

[1980] 1996)”. The year of the original publication should be given at least in the 

first citation of the work, and may be omitted in later citations.  

9.12. If the year of the first publication is not known, other conventions should be used, 

e.g. “(Poetics, 21)”, “(Poetics, 1458a 9-16)”, as customary for a given text or text 

type. Citations of the form “(Aristotle 1996: 55)” are not acceptable. The conven-

tion used should be explained, e.g. in a footnote, when applied for the first time (cf. 

(10.2 c), (12.2)). 

9.13. In grouped non-integral citations, i.e. those referring to multiple works and/or mul-

tiple authors, e.g. “(Meyerhoff 2004; Talbot 1998; Corbett 1991, 2000b)”, it is 

sometimes customary to group them with accordance to a) chronology (if the cita-

tion illustrates a historical overview of some research), or b) alphabetically by the 

surname (e.g. if the citation simply gives the names of researchers publishing within 

a given time period). Often, however, also the importance and relevance of the 

name(s) or publication(s) are taken into account: the sequence from more to less 

important can generally be advised. Please seek your supervisor’s advice on further 

details.  

9.14. The date of publication of a reprint edition should follow the year of the original 

publication, given in square brackets, e.g. “Arnauld and Lancelot ([1660] 1975: 
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22)”. The year of the original publication should be given at least in the first citation 

of the work, and may be omitted in later citations. 

9.15. Citations of works without a date take the following form: “(Talmy [n.d.])” (non-

integral citing), “Talmy ([n.d.]: 35)” (integral citation with a page cited), etc. 

9.16. Citations of Internet sources 

a) Citations of Internet sources consist of the author’s surname (or the title of the doc-

ument, if no author is given), followed by the year of publication (the same as the 

year of access, if no document-internal date is given; see also (16.13) below. 

b) The site’s URL may be given only when citing an entire Web site, or part of a Web 

site, rather than a specific document, e.g. “Being UNIX-based makes Mac OS X 

ideal for academic research (http://www.apple.com/education).” Note that the URL 

should also be listed in the References, either under the author or title of the site. 

For clarity, it might thus be preferable to cite authors / titles of websites rather than 

URLs. 

c) Some Internet-only text sources, such as web pages, blog posts, online encyclopedia 

articles, online papers and magazines and even some online periodicals, do not pro-

vide hard-coded page numbers. Citations to such texts, even if quoted from, are 

given without the page number, e.g. “Power (2005)”, “(“Concordancer” 2011)”. 

d) Citations to dictionaries and dictionary entries depend on the role of dictionaries in 

the text. In (lexicographic) studies which cite various dictionaries as primary 

sources, citations may make use of italicized abbreviated titles (cf. 10.4), e.g. 

“(MED, 6)”. (The first occurrence of the abbreviated title should be explained, e.g. 

in a parenthetical remark or footnote. Note also that a comma separates the abbre-

viated title and the page number if the publication year is not included in the cita-

tion.) For other studies, in which dictionaries and dictionary citations are few, an 

ordinary form of citing is usually preferable, e.g. “(Wells 1990: 23)” (when the 

author or editor is known) or “(Oxford English Dictionary on CD-ROM 1992)” (for 

dictionaries without indicated editors or authors). If needed, the title of the specific 

dictionary entry may be given in the sentence introducing, e.g., a quotation from 

this entry. In lexicographic studies alternative notation may be devised for reporting 

entries (on the supervisor’s advice) and explained in a gloss, footnote etc. (See also 

section (11) on the formatting of examples.)  
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e) Citations to e-book versions of book publications (which may have independent 

ISBN numbers for such editions) should follow the usual format, except the page 

number should be replaced by the implemented screen numbering index if availa-

ble, such as “Location” in the case of Kindle editions published by Amazon, e.g.: 

(Northedge 2005, loc. 2468). 

f) Note: web sites and other Internet materials which do not come from journals or 

books should only be used and cited to supplement officially published scientific 

and scholarly sources. 

 

9.17. Abbreviations and punctuation 

  

a) A comma is used to separate citations by the same author, e.g. “cf. Jespersen (1922, 

1924)”, “(cf. Jespersen 1922, 1924)”, while a semicolon is preferred to separate 

citations of works by different authors, especially in non-integral citations, e.g. “(cf. 

Greenberg 1966; Corbett 1991)” vs. “cf. Greenberg (1966), Corbett (1991)” (inte-

gral citing). 

b) The abbreviation “f.” stands for “the following page”, e.g. “Lakoff (1987: 48f.)”, 

while “ff.” stands for “the following pages”, e.g. “Heath (1984: 370ff.)”. 

c) “cf.” (= compare) is used when the author wishes to refer to other relevant publica-

tions (e.g. a similar, or contrasting, discussion, arguments, examples, etc.) which, 

however, are not quoted or directly paraphrased in the text. “See also” may be used 

to refer to additional publications. 

d) The abbreviations “ibid.” and “op cit.” may not be used.  

(Note: When having to refer to the same source more than once in a paragraph, 

consider placing a general citation to it in a summarising topic sentence at the top 

of the paragraph. Consecutive sentences may contain summary-reminder phrases 

which may not require a full citing form, such as “Cieślicka also points out that …” 

etc. An alternative approach, especially common in experimental studies, is to sum-

marize (all the relevant information from) a source and attach a non-integral citation 

at the end. Such practice is rather discouraged in theses, also because of the danger 

of citing ambiguously (cf. 9.2c). 
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e) The names of two authors of a publication are separated by “and”, e.g. “(Chambers 

and Trudgill 1980: 95)”. Notice that if a publication has more than two authors, 

only the surname of the first author should be used, followed by “et al.” (see 9.6). 

f) References to information obtained through personal communication, e.g. from a 

conversation, letter, email message or lecture, should be indicated by “p.c.”, e.g. 

“… (Peter Trudgill, p.c.)” (non-integral citing), and “Peter Trudgill (p.c.) …” (in-

tegral citing). (Note that personal communications should be excluded from the fi-

nal References list.)  

g) Citations to publications in press take the form: “Goodovsky (in press) ...” (integral 

citations), and “... (Goodovsky, in press)” (non-integral citations). 

h) Citations to works published in multiple volumes indicate the number of the volume 

after the publication year, e.g.: “Sacks (1992, 1: 27)” and “(Sacks 1992, 1: 27)”.  

 

(EndNote users: Some of the special punctuating conventions given above will not work 

automatically. Refer to the guides on the WA Stylesheet & Template Support site on 

Moodle). 

 

10. Abbreviations 

10.1. Abbreviations of names of languages 

 

a) Such abbreviations may only be used when followed by an example, e.g. “the mean-

ing of E drink has changed”. 

b) A full stop is used when an abbreviation ends in a small letter, e.g. Lat., Rus.; thus 

no full stop is used in, e.g., E, OE, EModE.  

c) Abbreviations need not be used when examples are given only from one language. 

 

10.2. Abbreviations of titles of literary works 

 

a) The titles of literary works which are frequently referred to may be abbreviated, e.g. 

Wuthering Heights as “WH”, or The French Lieutenant’s Woman as “FLW”. Note 
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that the abbreviated title should appear in italics (similarly, abbreviations of other 

titles in sections (10.3) and (10.4) below). 

b) Abbreviations of the titles of literary works thus include the first letters of the words 

constituting the title, except for functional words such as articles, etc. This is the 

case when the title is comprised of more than one word. In the case of one-word 

titles (again, excluding function words), e.g. The Tempest, the abbreviation may 

contain the first three or four letters of the title word followed by a full stop, e.g. 

“Temp.”.  

c) When the title of a literary work is referred to for the first time it should be given 

in full, e.g. Wuthering Heights, followed by the indication that its abbreviated form 

will be used on the remaining pages: “Wuthering Heights (henceforth WH)”. Such 

an indication can be given in the text or in a footnote. 

 

10.3. Abbreviations of titles of scholarly publications 

 

The abbreviated title (i.e. a short form of the title) may be used when referring to a well-

known publication (important to the current text), e.g. Chomsky’s Aspects. The first men-

tion should be accompanied by a citation, i.e. “(Chomsky 1965)”. 

 

 

10.4. Abbreviations of titles of dictionaries and names of corpora 

 

Such titles or names may be abbreviated, e.g. OED, BNC (for Oxford English Dictionary 

and British National Corpus, respectively). An explanation should be provided with the 

first occurrence of the abbreviation, e.g. “examples have been taken from the Oxford 

English Dictionary (henceforth OED) … ”. The abbreviation of a dictionary should also 

appear with its entry in the References (see section (17.3) below for some examples). 

 

10.5. Abbreviations of frequently used terms 

 

Abbreviations of frequently used terms may be used, e.g. “CS” for code-switching. An 

explanation should be provided with the first occurrence of the abbreviation, e.g. “Code-

switching (henceforth CS) … ”. 
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10.6. Punctuation in abbreviations 

 

a) “e.g.” and “i.e.” should be preceded by a comma, with no comma following, e.g. 

“marking an adequate representation, e.g. when ...”, except when “e.g.” is an inser-

tion, as in “this aspect has been described in, e.g., Humbley (2002: 121-122)”. 

b) For abbreviations used in citations see section (9.17) above.  

11. Examples 

11.1. Font style 

 

All linguistic examples should be given in italics (except when representing phrase/sen-

tence structure). Examples may not be enclosed in quotation marks. 

 

11.2. Numbering 

 

Examples which are not included in the text of a paragraph should be numbered, with the 

number placed in parentheses. Tabs (not spaces) should be used to align the examples. 

Sets of related items may be listed together, and numbered with lowercase letters, as in 

the example below which shows two different types of classifying morphemes in English: 

 

(1)   a. a slice of bread, a glass of water 

 b. a pile of books, a row of houses 

(2)    strawberry, raspberry, blueberry 

 

a) Examples should be numbered consecutively throughout the whole text. List num-

bering may be used in the editor to number the examples automatically. This allows 

adding and updating cross-references to examples. To enable it, choose Format > 

Bullets and Numbering > Numbered, or right-click and choose Bullets and 

Numbering > Numbered. 

b) The preceding and the following text should be separated from the example(s) by 

one blank line. 
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c) References to numbered examples should take the following form: “as in (1b) and 

(2)”. See section (13.8) on inserting cross-references. 

 

11.3. Translation 

 

Examples from languages other than English must be translated and placed within single 

quotation marks; the closing quotation mark should precede punctuation marks, e.g. “such 

a semantic change occurred in P kobieta ‘woman’, and other examples”. 

In examples which are not included in the text of a paragraph a translation should 

be placed in the next line following the example, as shown below: 

 

(3)  Arma virumque cano. 

  ‘I sing about weapons and the man.’ 

  

If a word-for-word or a morpheme-by-morpheme gloss is necessary, it should be provided 

between the example and the translation: 

 

(4)   Arm-a vir-um-que can-o 

  weapon-NEUT.ACC.PL man-MASC.ACC.SG-and sing-1SG.PRES.IND 

 ‘I sing about weapons and the man.’ 

 

a) the glosses should be aligned with the original words with tabs 

b) morphemes in the original words and the glosses should be separated with hyphens 

c) periods should be used to separate abbreviations of grammatical categories 

d) roots should be glossed using lowercase letters, while small capitals should be used 

to gloss abbreviated grammatical categories 

e) all abbreviations used must be listed in the List of abbreviations 

 

11.4. Transliteration 

 

Examples from languages which do not use Latin script, e.g. Russian or Greek, must be 

transliterated. Note that this does not apply to Greek letters used as symbols, e.g. “χ2”. 
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The transliteration should conform to the ISO standard (see examples in pdf files at 

http://transliteration.eki.ee/). 

 

11.5. Transcription 

 

Phonetic or phonemic transcriptions should be enclosed in square brackets or slashes re-

spectively. 

 

11.6. Special characters 

 

a) for phonetic characters and diacritics: Doulos SIL (available in Mac, Linux and 

Windows versions at http://scripts.sil.org) 

b) for other special characters the Insert > Symbol function should be used; if in 

doubt, consult your supervisor 

 

No characters or diacritics may be inserted by hand; if in doubt, please consult your su-

pervisor. 

 

11.7. Punctuation 

 

Examples of morphemes and graphemes should be enclosed in braces and angle brackets 

respectively, e.g. “the morpheme {-er}”, “the grapheme <þ>”. 

 

11.8. Discourse examples 

 

Simple excerpts of dialogue should be numbered and formatted in the standard manner, 

with a possible citation to the source given in the leading sentence or at the end of the 

example and right-aligned, e.g.: 

 

(5) Mother: Har du din nyckel? ‘Have you got your key?’ 

Finn: Jo, jag har den – hej, hej. ‘Yes, I’ve got it, goodbye.’ 

Mother: Hej då. ‘Bye, then.’ 

Finn: [Now addressing his father] Goodbye.  

http://transliteration.eki.ee/
http://scripts.sil.org/
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Father: Bye, Finn. 

(Harding-Esch and Riley 2003: 64) 

 

If the example contains a title or description, it may be given on the first line, e.g.: 

 

(6) English/Swedish code-switching, Finn (14 years) is just off to school: 

Mother: Har du din nyckel? ‘Have you got your key?’ 

Finn: Jo, jag har den – hej, hej. ‘Yes, I’ve got it, goodbye.’ 

Mother: Hej då. ‘Bye, then.’ 

Finn: [Now addressing his father] Goodbye.  

Father: Bye, Finn. 

(Harding-Esch and Riley 2003: 64) 

 

Annotated transcriptions of discourse examples should be numbered and formatted ac-

cording to a convention selected for reasons of research aims and the type of data ana-

lysed, as agreed with the supervisor (e.g. Conversation Analysis convention). For in-

stance, excerpts of dialogues can be transcribed depending on whether linguistic as well 

as paralinguistic and interactional aspects of data are considered (turn taking structure, 

pausing, overlapping speech, etc.). In the example below the following transcription sym-

bols are used to indicate: 

- turn numbers (rather than line numbers) 

- names of participants 

- pauses (.) 

- onset of simultaneous speech // 

- ‘latching’ (no gap, no overlap) = 

 

(7) 1 Ed:   that // guy 

2 Bryan: // it’s like a speedo he wears a speedo to class (.) he’s got incredibly 

skinny legs 

3 Ed:   it’s worse= 

4 Bryan:  = you know 

5 Ed:  you know like those shorts women volleyball players wear? 

(Cameron 2001: 37) 
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The choice of the selected convention and explanation of the symbols used should be 

given in the main text or a footnote accompanying the first example. 

 

Once established, the same convention should be rigorously applied to all pertinent dis-

course examples. 

 

(See also the example of the formatting of a vertically aligned concordance in (4.2).) 

 

 

11.9. Literary examples 

 

Literary excerpts used as examples, including dialogues, should follow the formatting 

recommendations for quoting (cf. section 8).  

12. Footnotes 

12.1. The purpose of footnotes is to give a comment or additional information to the ar-

gument in the main text, and not to provide a citation of a source (cf. section (9) 

below).  

12.2. Footnotes may be used to provide additional information about the works used, 

such as full title (see (10.2), (10.3)), edition used or translation of quotations 

(8.3)). 

12.3. Acknowledgement footnote: an acknowledgement may only be made to express 

thanks for specific assistance, such as helping with data collection or suggesting an 

idea/solution. Such an acknowledgement should be included in an acknowledge-

ment footnote on the page in question. 

12.4. Footnotes appear at the bottom of the page and not at the end of the text (i.e. they 

are not endnotes). 

12.5. Footnotes should be numbered consecutively throughout the text. To insert a foot-

note choose Insert > Footnote (examples of footnotes are provided in the WA 

Template). When a footnote number appears at the end of a sentence it should fol-

low the punctuation mark. 
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12.6. The text of footnotes should be formatted as Times New Roman size 10, single 

spaced. 

13. Tables, figures, diagrams and illustrations  

13.1. All tables, figures, diagrams and illustrations should be numbered consecutively 

throughout the thesis and a complete list (e.g. List of tables) should be provided on 

the page(s) following the Table of contents. All should be provided with appropriate 

captions, consisting of a number and a concise description. Captions for tables ap-

pear above the table, while captions for figures, diagrams and illustrations appear 

below the figure/diagram/illustration. The captions should be centred. 

13.2. Table 1 shows the judgements of three groups of native speakers of English (British, 

American and New Zealand) regarding the sentence The audience were enjoying 

every minute of the show (after Corbett 2000b: 189): 

 

Table 1. Judgements on agreement with ‘corporate’ nouns in three varieties of English. 

 variety 

GB (N = 92) US (N = 93) NZ (N = 102) 

response (%) 

no correction 77.2 5.4 72.5 

was enjoying 15.2 90.3 20.6 

other response 7.6 4.3 6.9 

 

 

Table 2 shows the paradigm of Russian byl ‘was’ (adapted from Corbett 2000b: 272): 

Table 2. The paradigm of Russian byl ‘was’. 

 singular plural 

masculine byl byl-i 

feminine byl-a byl-i 

neuter byl-o byl-i 
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13.3. Fig. 1 is an example of a simple figure: 

 

 
 

NP NP NP   TARGET 

Fig. 1. Agreement with the nearest conjunct (after Corbett 2000b: 196). 

 

13.4. The following are examples of types of illustrations: photograph, advertisement, 

comic strip, painting. Illustrations may be inserted into the document (choose In-

sert > Figure) or manually glued onto the page.  

13.5. Fig. 2 is an example of a simple diagram: 
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Fig. 2. Frequency of dictionary consultation (after Lew 2004: 81). 

 

13.6. Formatting  

 

a) Tables can be formatted manually; a simpler option, however, may be to use auto-

matic formatting. In MS Word, choose Table > Table AutoFormat (‘Tabela > 

Autoformatowanie tabeli’) and apply a style, after having unchecked the “colour” 

(‘kolor’) option. 

b) The above tables have been formatted as “Simple 1” (‘Proste 1’). While other for-

matting styles may be used, framing should be used moderately whereas shading 

should be avoided. Please refer to sections (4) and (6) above for the use of fonts and 
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spacing in tables. The text in the sample table in the WA Template uses the style 

“IFA table text”. 

c) Diagrams and charts may use colour when justified, but authors should make sure 

that all the important distinctions should be apparent in greyscale, i.e. visible also 

on a black-and-white printout. 

d) In tables numbers are centred and decimal-aligned, i.e. aligned on their decimal 

points, while text is left-justified (see examples in (13.2) above). 

 

13.7. Captions 

 

a) Instead of adding the caption manually, it is a better idea to add it automatically. 

First, the caption must be formatted automatically in order to create the List of ta-

bles, and second, the table number is updated whenever the position of the table is 

changed. 

b) To add a caption to a table select the table and choose Insert > Caption. Type in 

the caption text, choose the type of label and specify the position (above the selected 

item). The caption above the sample table in the WA Template uses the style ‘Cap-

tion’ (‘Legenda’). 

c) Other options that can be used here include AutoCaption, which adds a caption for 

an item such as a table whenever it is inserted into the document, and New Label, 

which allows you to add custom labels, e.g. for illustrations or extracts. 

 

13.8. Cross-references 

 

a) Cross-references can be used to refer to tables, figures, bookmarks, headings and 

other items in the text. As in captions, they are updated automatically whenever the 

referenced item changes its position. 

b) In order to add a (clickable) cross-reference, choose Insert > Cross-reference, and 

then select Table as the Reference type, Only label and number as Insert reference 

to, and finally choose the particular table in the list that you want to refer to. The 

cross-reference will take the following format: “Table 1 shows the distribution of 

…” (To remove the blue colour and the underlining from the link, or any other 

automatically added formatting such as bold, apply an appropriate style to the 
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excerpt, as has been done here: “Table 1 shows the distribution of ...”. It is also 

possible to pre-set the formatting of hyperlinks in most editing software; please 

refer to your documentation.) 

14. Appendix 

14.1. The appendix (appendices) follow the References; for the function and possible 

contents of the appendix consult the supervisor. 

14.2. The pages of the appendix (appendices) are numbered consecutively. 

14.3. Appendices are ordered using capital letters and may be given titles. The appendix 

(appendices) should be included in the Table of contents. 

14.4. References to appendices should take the format as in: “The relevant data is pro-

vided in Appendix A, p. xx”. 

15. Orthography 

Either British or American English should be chosen and used consistently, except in 

quotations, where the original spelling should be retained. It is absolutely essential that 

the spell checker and hyphenation options be used. To enable these options, the text 

should be marked as English (UK or US) in the language options (choose Tools > Lan-

guage > Set Language). Parts of the text may also be marked as, e.g. Polish or German, 

depending on the language quoted. To enable the spell checker choose Tools > Options 

> Spelling & Grammar; for hyphenation choose Tools > Language > Hyphenation (it 

is turned on by default in the WA Template).  

Note, however, that the spell checker should be used with caution, especially in 

the case of quoted text, as it may change spellings which are not listed in the program 

dictionary or convert British spelling when US spelling is adopted for the thesis. Also, it 

is advised that automatic language detection be turned off in your word processor, as the 

error rate tends to be high for languages other than English: for the hyphenation and spell-

checking rules to work best in multi-lingual texts, mark any switches between languages 

manually. 
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16. References 

See section (18) for a list of sample references. 

 

(EndNote users: refer to the guides on the WA Stylesheet & Template Support site on 

Moodle for detailed information on the formatting of the references in an EndNote data-

base library for compliance with the WA Stylesheet style for EndNote.) 

 

16.1. Introduction 

 

a) References should be arranged alphabetically, by surnames of the authors.  

b) If no author/editor is given then references should be arranged alphabetically by the 

first word of the title, with the title followed by the date, as in the entry for the 

Encyclopaedia Britannica in the Sample references. 

c) If the editor name is missing or unknown then the reference should be provided at 

the end, using the convention described in (16.14 b). 

d) If primary and secondary sources are distinguished, they should be listed in separate 

sections, e.g. “Primary sources” and “Secondary sources” or “Other works”. Also, 

if more sources of a specific kind are used in the work, they may be listed separately 

and given a specific label, e.g. “Dictionaries”, “Corpora”, “Song lyrics”, etc. 

 

16.2. Paragraph, fonts and special characters 

 

a) Each entry forms a separate hanging indented paragraph. 

b) For the use of fonts in titles see section (16.7) below. 

c) Care should be taken to preserve all special characters in titles, e.g. acute and grave 

accents (á, à), umlauted vowels (ä, å). 

 

Bammersberger, Alfred. 1972. “Altenglisch hlæfþe”, Zeitschrift für vergleichende Spra-

chforschung 86: 307-311. 

Flasdieck, Hermann M. 1937. “Ae. dōn und ʒān”, Anglia 61: 43-64. 

 

16.3. Authors’ names 
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a) Full first names of authors should be given, unless the author normally uses initials, 

e.g. L. G. Alexander, M. A. K. Halliday, Nancy C. Dorian. 

b) Historical names are given according to convention. 

 

Aristotle. 1996. Poetics. (Translated by Malcolm Heath.) London: Penguin. 

Beowulf. 1999. (Translated by Seamus Heaney.) London: Faber and Faber. 

Chaucer, Geoffrey. 1987. The Riverside Chaucer. (3rd edition, edited by Larry D. Ben-

son.) Oxford: Oxford University Press. 

Fielding, Henry. 1969. The history of Tom Jones. (Edited by R. P. C. Mutter.) Har-

mondsworth: Penguin Books. 

McEwan, Ian. 2002. Atonement. London: Vintage. 

Shakespeare, William. [1623] 1999. The Tempest. (Edited by Virginia Mason Vaughan 

and Alden T. Vaughan. The Arden Shakespeare edition.) London: Thomas Nel-

son and Sons. 

Sir Gawain and the Green Knight. [n.d.] 1972. (Edited by J. A. Burrow.) Harmonds-

worth: Penguin Books. 

 

16.4. Several entries by the same author  

 

a) Multiple works by the same author should be listed chronologically. The author’s 

name appears with every item listed. 

b) If several entry types are given for the same person, they should be listed in the 

following order: authored works, co-authored works (if first author), edited works, 

co-edited works (if first editor). 

c) When more than one work is given for an author in the same year, they should be 

listed alphabetically by title and distinguished by small roman letters (a, b, c, etc.). 

d) Care should be taken to maintain the same numbering in citations within the text, 

to avoid situations where, e.g., two items are given for an author in the References 

(e.g. Clyne 1987a, 1987b), while a citation in the text is made to “Clyne (1987)”.  

 

16.5. Entries with multiple authors 
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a) In entries with multiple authors, the authors’ names should be listed in the following 

order: surname and first name of the first author, followed by the first name(s) and 

surname(s) of the other author(s).  

b) Particular authors’ names should be separated by “and” (with two authors), and a 

comma and “and” (with more than two authors), without a comma before the last 

name. A long dash (–) or an ampersand (&) may not be used. 

c) Multiple works by exactly the same group of authors with the same name as the 

first author, should be listed chronologically. 

 

Chambers, Jack K. and Peter Trudgill. 1980. Dialectology. Cambridge: Cambridge Uni-

versity Press. 

Hale, Ken, Michael Krauss, Lucille J. Watahomigie, Akira Y. Yamamoto, Colette 

Craig, LaVerne Masayesva Jeanne and Nora C. England. 1992. “Endangered 

languages”, Language 68, 1: 1-42. 

McEnery, Tony and Costas Gabrielatos. 2004. “English corpus linguistics”, in: Bas 

Aarts and April McMahon (eds.), The handbook of English linguistics. Malden: 

Blackwell Publishing, 33-71. 

McEnery, Tony and Andrew Wilson. 2001. Corpus linguistics: An introduction. (2nd 

edition.) Edinburgh: Edinburgh University Press. 

McEnery, Tony, Richard Xiao and Yukio Tono. 2006. Corpus-based language studies: 

An advanced resource book. Abington: Routledge. 

 

d) All the names of the authors should be given in the References, even if a citation is 

given in the text of a publication with more than two authors (with “et al.”). 

 

16.6. Alphabetization 

 

a) The listing and alphabetization of surnames with particles (such as “van”, “von”, 

“de la”, etc.) should be guided by the most frequent usage of a given surname. (See 

also 9.8 on the usage of such particles in citations.) 

b) Abbreviations should be alphabetized as if they were spelled out, e.g. “St.” alpha-

betized as “Saint”. 

c) “Mc” and “Mac” should be listed (under M) as if they were spelled “Mac”.  
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d) Historical names are alphabetized under the first name, e.g. Martin of Dacia, John 

of Salisbury. 

e) Diacritics are generally ignored for the purpose of alphabetization. In the event of 

names differing only in a diacritical letter, the item without the diacritic should be 

listed first (e.g. “Matek, Roman” should be listed before “Mątek, Roman”, “Latek, 

Zbigniew” before “Łątek, Zbigniew” etc.). 

 

(EndNote users: please note that some rules for the alphabetic ordering of References are 

not supported by EndNote automatically. Refer to the guides on the WA Stylesheet & 

Template Support site on Moodle for more information.) 

 

16.7. Titles 

 

a) Titles of books, journals, periodicals and films appear in italics. 

b) Book titles should be given in italics. Within book titles linguistic examples, quoted 

terms, phrases, utterances and titles of literary works appear in single quotation 

marks. 

 

Bitterling, Klaus (ed.). 1998. Of shrifte and penance: The ME prose translation of ‘Le 

Manuel des Péchés’. Heidelberg: Winter. 

Holmqvist, Erik O. 1922. On the history of the English present inflections, particularly 

‘-th’ and ‘-s’. Heidelberg: Winter. 

Kytö, Merja. 1991. Variation and diachrony, with Early American English in focus: 

Studies on ‘can/may’ and ‘shall/will’. Frankfurt am Main: Peter Lang. 

Mugglestone, Lynda. 1995. ‘Talking proper’: The rise of accent as social symbol. Ox-

ford: Clarendon Press. 

 

c) Titles of articles appear in double quotation marks. Within titles of articles italics 

should be used for linguistic examples (e.g. morphemes, words, phrases) or titles of 

other works (but only those works which exist physically on their own, e.g. books). 

Single quotation marks should be used for examples of utterances and other exam-

ples of discourse within article titles. 
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Krygier, Marcin. 1994. “The strong verb system in the Peterborough Chronicle”, Studia 

Anglica Posnaniensia 28: 49-69. 

Lass, Roger. 1997. “Arse longa, vita brevis: Last words on ‘harmful homophony’”, 

Studia Anglica Posnaniensia 32: 21-32. 

Rissanen, Matti. 1985. “Periphrastic do in affirmative statements in Early American 

English”, Journal of English Linguistics 18: 163-183. 

Tieken-Boon van Ostade, Ingrid. 1985. “‘I will be drowned and no man shall save me’: 

The conventional rules for shall and will in eighteenth-century English gram-

mars”, English Studies 2: 123-142. 

Wierzbicka, Anna. 1982. “Why can you have a drink when you can’t *have an eat?”, 

Language 58, 4: 753-799. 

 

d) Titles of poems or short stories should be given in double quotation marks. 

 

Mansfield, Katherine. [1820] 1962a. “Bliss”, in: Katherine Mansfield, Bliss and other 

stories. Harmondsworth: Penguin Books, 95-110. 

Mansfield, Katherine. [1820] 1962b. “The escape”, in: Katherine Mansfield, Bliss and 

other stories. Harmondsworth: Penguin Books, 212-219. 

Szymborska, Wisława. 2004. “Konkurs piękności męskiej” [Bodybuilders’ contest], in: 

Wisława Szymborska, Wiersze wybrane [Selected poems]. Kraków: Wydawnic-

two a5, 91. 

 

 

e) Titles of book reviews, book notices, review articles without independent titles, 

obituaries, works in preparation, unpublished dissertations and theses, manuscripts, 

papers presented at conferences etc., and several types of Internet sources (e.g. 

course materials or personal pages) are given in a plain font, without quotation 

marks or italics. For details, review section (17). 

 

16.8. Capitalization 

 

a) In book and article titles capital letters should be used as in a regular sentence (with 

only the first word and proper nouns capitalized). Consult the supervisor for the 
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capitalization in titles of literary works. On the capitalization of translated titles, see 

(16.11c). 

b) Titles of the following types of references should be capitalized as in the original 

and not in the “as-in-a-sentence” format: titles of book series, works of art (includ-

ing music albums, but not individual pieces in a collection), web sites (including 

blog titles, but not individual web pages or entries), online multimedia, podcast se-

ries, (online) databases, (some) dictionaries (especially those commonly abbrevi-

ated, e.g. Oxford English Dictionary), corpora and computer programs. (On abbre-

viated titles, see sections (10.3) and (10.4)). 

c) Names of institutions or conferences included in the title should be capitalized, e.g. 

 

Ahlqvist, Anders (ed.). 1982. Papers from the 5th International Conference on Histori-

cal Linguistics. Amsterdam: John Benjamins. 

  

 

d) A capital letter must follow a full stop or a colon. 

 

Lakoff, George. 1987. Women, fire and dangerous things: What categories reveal about 

the mind. Chicago: University of Chicago Press. 

 

 

 

e) Names of journals should be capitalized, with the exception of words that are not 

normally capitalized in a given language, e.g. “Language in Society”, “Język a Kul-

tura”, “Zeitschrift für Deutsche Philologie”.  

 

 

16.9. Abbreviations 

 

a) Abbreviations should not be used for the names of publishers, e.g. “Cambridge Uni-

versity Press” instead of “CUP”, unless an abbreviation is a part of the publisher’s 

name, e.g. “MIT Press”. 



WA Stylesheet 1.5.2 (Updated: 28 March 2022) 40 

b) Abbreviations of names of US states should take the form of, e.g., “MA” instead of 

“Mass.” for Massachusetts.  

c) The ampersand (&) may only be used when it is a part of a publisher’s name, as 

given on the title page, e.g. “Simon & Schuster”. 

d) On abbreviated titles of works, see sections (10.3) and (10.4). 

 

16.10. Punctuation 

 

a) Subtitles in titles of books and articles are preceded by a colon, with a capital letter 

following the colon. If in the original publication there is a full stop between the 

title and the subtitle, it should be replaced with a colon. 

b) For the use of quotation marks in titles see section (16.7) above. 

c) If the title of an entry given in italics (e.g. book) or in a plain font without italics or 

quotation marks (e.g. thesis, web page) ends with a question mark or exclamation 

mark, the full stop that standardly follows the title should not be used, e.g.: 

 

Ryfa, Joanna. 2003. Estuary English: A controversial issue? [Unpublished post-graduate 

diploma paper, Adam Mickiewicz University, Poznań.]. 

 

d) If more than one publisher is given, the items are separated by “and”, e.g. “John 

Benjamins and Adam Mickiewicz University Press”; if more than one place of pub-

lication is given in the publication, only the first place should be given, i.e. “Am-

sterdam” and not “Amsterdam and Philadelphia”. 

e) Page numbers are written in full, e.g. “341-349”. A short hyphen (-), without spaces 

around, and not a long dash (–), should be used. 

f) Each entry should end with a full stop. 

 

16.11. Translation 

 

a) Titles of publications in languages other than English, French, German and Latin 

should be translated, with the translation following the original title and given in 

square brackets, e.g.  
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Mańczak-Wohlfeld, Elżbieta. 1988. “Liczba mnoga zapożyczeń angielskich” [The plu-

ral of English loanwords], Poradnik Językowy 7: 512-514. 

Mańczak-Wohlfeld, Elżbieta. 1995. Tendencje rozwojowe współczesnych zapożyczeń 

angielskich w języku polskim [Developments in contemporary English borro-

wings in Polish]. Kraków: Uniwersytet Jagielloński. 

 

Translated titles are always capitalized “as in a sentence”, even if the original title does 

not follow this rule (e.g. literary works, works or art or internet web sites – cf. 16.8 b) 

 

b) titles of parallel-text editions 

 

Szymborska, Wisława. 1997. Nic dwa razy: Wybór wierszy / Nothing twice: Selected 

poems. (Selected and translated by Stanisław Barańczak and Clare Cavanagh.) 

Kraków: Wydawnictwo Literackie. 

 

c) translated publications 

 

de Beaugrande, Robert-Alain and Wolfgang Ulrich Dressler. 1990. Wstęp do lingwistyki 

tekstu [Introduction to text linguistics]. (Translated by Aleksander Szwedek.) 

Warszawa: Państwowe Wydawnictwo Naukowe. 

Eco, Umberto. 1983. The name of the rose. (Translated by William Weaver.) San Di-

ego: Harcourt Brace. 

 

The title of the original publication may be given in square brackets following the title of 

the translation. 

 

d) The place of publication and the name of the publisher are given in the same lan-

guage as they appear in the original publication, e.g. 

 

Kopcewicz, Andrzej and Marta Sienicka. 1983. Historia literatury Stanów Zjed-

noczonych w zarysie: Wiek XVII-XIX [An outline history of the literature of the 

United States: 17th-19th centuries]. Warszawa: Państwowe Wydawnictwo Nau-

kowe. 
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Rajnik, Eugeniusz. 1999. Gramatyka języka duńskiego [Danish grammar]. Poznań: 

Wydawnictwo Uniwersytetu im. Adama Mickiewicza. 

 

16.12. Transliteration 

 

Titles in languages which do not use Latin script should be transliterated (see (11.4) 

above). 

 

Dul’zon, Andrej Petrovich. 1968. Ketskij jazyk [The Ket language]. Tomsk: Izdatel’stvo 

Tomskogo Universiteta. 

 

16.13. Dates 

 

a) The year of the original publication (if known) of a recent edition of a literary work 

of the past should be given in square brackets, followed by the year of the edition 

used. 

 

Shakespeare, William. [1623] 1999. The Tempest. (Edited by Virginia Mason Vaughan 

and Alden T. Vaughan. The Arden Shakespeare edition.) London: Thomas Nel-

son and Sons. 

 

 

If the year of the first publication is not known, only the year of the edition used should 

be given, e.g. 

 

Aristotle. 1996. Poetics. (Translated by Malcolm Heath.) London: Penguin. 

 

(Note, however, that in-text citations to old, undated works should not include the year of 

the contemporary edition, but other conventions of citing apply, cf. (9.12).) 

 

b) In publications available online two dates should be given: the internal date (the 

date given in the document) following the author’s name, and the date of access 
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following the URL (Internet address). If the document is not dated internally, the 

date of access should appear in both places. 

c) The date should take the format “dd month yyyy”, with an abbreviated name of the 

month (except for the months with four or fewer letters, as in the MLA standard): 

Jan., Feb., Mar., Apr., May, June, July, Aug., Sept., Oct., Nov., Dec. 

 

Krynicki, Grzegorz. 2005. Language and society: Polish and English terms of address. 

(http://elex.amu.edu.pl/~krynicki/my_pres/my_pres_14.htm) (date of access: 15 

Jan. 2005). 

 

16.14. Unknown or missing details 

 

(EndNote users: Refer to the guides on the WA Stylesheet & Template Support site on 

Moodle for more information on how to fill in the the author, editor etc. fields to ensure 

correct formatting of the details described below.) 

 

a) author 

 

Sir Gawain and the Green Knight. [n.d.] 1972. (Edited by J. A. Burrow.) Harmonds-

worth: Penguin Books. 

The ladies complete letter-writer. 1763. London: T. Lownds. 

 

 

b) editor 

 

In the unlikely event of the name(s) of the editor(s) being unknown and impossible to 

determine, the notation “[no editor] (ed.)” should be used. This does not apply to ency-

clopedias or dictionaries (cf. 17.3 c) and articles and entries appearing in them (cf. 17.9). 

If listed separately in the References, edited collections (17.2) and conference proceed-

ings (17.4) beginning with “[no editor]” should be listed last on the list.  
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(EndNote users: Entries beginning with “[no editor]” will not be automatically sorted in 

the References. Refer to the guides on the WA Stylesheet & Template Support site on 

Moodle for more information.) 

 

c) publisher 

 

Lunt, Horace G. 1952. A grammar of the Macedonian literary language. Skopje: [No 

indication of publisher.]. 

 

d) date 

 

Talmy, Leonard. [n.d.]. A comparison of the order of morpheme-classes in the 

Atsugewi and the Kashaya verb. [Unpublished ms.]. 

 

 

17. Types of references 

17.1. Books [Book, Edited Book ] 

 

Entries should contain the following elements (optional elements are here given in paren-

theses):  

 

(First) author’s surname, first name(s).  

Year of publication.  

Full title (and subtitle) of the work.  

(Edition.)  

(Volume or part number).  

(Series title.)  

Place of publication:  

Publisher. 

 

a) with one author 
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Anderson, James M. 1973. Structural aspects of language change. London: Longman. 

Cieślicka, Anna. 2004. On processing figurative language. Poznań: Motivex. 

Givón, Talmy. 1979. On understanding grammar. New York: Academic Press. 

 

b) with more than one author 

 

Baerman, Matthew, Dunstan Brown and Greville G. Corbett. 2005. The syntax-mor-

phology interface: A study of syncretism. Cambridge: Cambridge University 

Press. 

Chambers, Jack K. and Peter Trudgill. 1980. Dialectology. Cambridge: Cambridge Uni-

versity Press. 

 

c) editions 

 

Milroy, Lesley. 1980. Language and social networks. (2nd edition.) Oxford: Blackwell. 

 

d) parts or volumes 

 

The content of the entry is based on the format of the publication and the information 

given on the title page of the publication: 

 

▪ when published as a single volume divided into parts 

 

Unterbeck, Barbara and Matti Rissanen (eds.). 2000. Gender in grammar and cognition. 

Part 1. Approaches to gender. Part 2. Manifestations of gender. Berlin: Mouton 

de Gruyter. 

 

▪ when published as one volume of a multi-volume work 

 

Blake, Norman (ed.). 1992. The Cambridge history of the English language. Vol. 2: 

1066-1476. Cambridge: Cambridge University Press. 
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Labov, William. 2001. Principles of linguistics change. Vol. 2: Social factors. Oxford: 

Blackwell. 

 

▪ when published as a work divided into several volumes either in the same year or 

over several years 

 

Hellinger, Marlis and Hadumod Bußmann (eds.). 2001-2003. Gender across languages: 

The linguistic representation of women and men. 3 vols. Amsterdam: John Ben-

jamins. 

Holt, Thomas C. and Elsa Barkley Brown (eds.). 2000. Major problems in African-

American history: Documents and essays. Vol. 1: From slavery to freedom, 

1619-1877. Vol. 2: From freedom to ‘Freedom Now’, 1865-1990s. Boston: 

Houghton Mifflin. 

 

e) privately printed  

 

Johnson, Richard. 1718. Grammatical commentaries: Being an apparatus to a new na-

tional grammar: By way of animadversion upon the falsities, obscurities, redun-

dancies, and defects of Lilly's system now in use. London: Printed for the author 

and sold by Samuel Ballard. 

 

17.2. Edited collections [Book, Edited Book ] 

 

Edited collections follow largely the same organisation of the entry as (authored) books 

(cf. some examples in (17.1) above), except that editor and not author names appear first. 

Single editor names are followed by “(ed.)”, while multiple editor names are followed by 

“(eds.)” (with a full stop). 

 

a) with one editor 

 

Dziubalska-Kołaczyk, Katarzyna (ed.). 2006. IFAtuation: A life in IFA. A Festchrift for 

Professor Jacek Fisiak on the occasion of his 70th birthday. Poznań: Wydawnic-

two Naukowe UAM. 
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Greenberg, Joseph H. (ed.). 1963. Universals of language. Cambridge, MA: MIT Press. 

 

b) with more than one editor 

 

Ammon, Ulrich, Klaus J. Mattheier and Peter H. Nelde (eds.). 1996. Convergence and 

divergence of dialects in Europe. Tübingen: Niemeyer. 

 

c) further information about the editor(s) 

 

Grimm, Jacob. [1831] 1890. Deutsche Grammatik. Vol. 3. (2nd edition, edited by Gus-

tav Roethe and Edward Schröder.) Güthersloh: C. Bertelsmann. 

 

d) series 

 

Ross, Woodburn O. (ed.). 1998. Middle English sermons. (EETS OS 209.) London: Ox-

ford University Press. 

Sebeok, Thomas A. (ed.). 1973. Linguistics in North America. (Current Trends in Lin-

guistics 10.) The Hague: Mouton. 

 

17.3. Dictionaries, encyclopedias, atlases [Book, Edited Book ] 

 

a) with one or more authors 

 

Bosworth, Joseph and T. Northcote Toller. 1898. An Anglo-Saxon dictionary. Oxford: 

Clarendon Press. 

Wells, J. C. 1990. Longman pronunciation dictionary. Harlow: Longman. 

 

b) with one or more editors 

 

Bright, William (ed.). 1992. International encyclopedia of linguistics. New York: Ox-

ford University Press. 

Kurath, Hans, Sherman M. Kuhn and Robert E. Lewis (eds.). 1952-2001. Middle Eng-

lish dictionary [MED]. Ann Arbor: University of Michigan Press. 
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McIntosh, Angus, Michael L. Samuels and Michael Benskin (eds.). 1986. A linguistic 

atlas of late medieval English [LALME]. 4 vols. Aberdeen: Aberdeen University 

Press. 

 

c) with no indication of editors 

 

Encyclopaedia Britannica. 1929. (14th edition.) London: Encyclopaedia Britannica 

Company. 

 

(Note a different notation for edited collections (books) with unknown editors, cf. (16.14 

b).) 

 

17.4. Conference proceedings [Edited Book ] 

 

Ahlqvist, Anders (ed.). 1982. Papers from the 5th International Conference on Histori-

cal Linguistics. Amsterdam: John Benjamins. 

 

17.5. Articles in journals [Journal Article ] 

 

Entries should contain the following elements:  

 

(First) author’s surname, first name(s).  

Year of publication.  

“Full title (and subtitle) of the work”,  

Full name of the journal  

Volume number (and issue number):  

Page numbers. 

 

Article titles are enclosed within double quotation marks. 

 

a) with one or more authors 

 

Anderson, Stephen R. 1982. “Where's morphology?”, Linguistic Inquiry 13: 571-612. 
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Hale, Ken, Michael Krauss, Lucille J. Watahomigie, Akira Y. Yamamoto, Colette 

Craig, LaVerne Masayesva Jeanne and Nora C. England. 1992. “Endangered 

languages”, Language 68, 1: 1-42. 

Heath, Jeffrey G. 1984. “Language contact and language change”, Annual Review of 

Anthropology 13: 367-384. 

 

b) with volume (and issue) 

 

Cheshire, Jenny. 2000. “The telling or the tale? Narratives and gender in adolescent 

friendship networks”, Journal of Sociolinguistics 4, 2: 234-262. 

 

c) published in parts of the same journal  

 

Anderson, James. 1792. “Grammatical disquisitions”, The Bee 11: 120-130, 193-204, 

240-250. 

 

d) published over several years 

 

Nordfelt, Alfred. 1901-1943. “Om franska lånord i svenskan. 1-6” [On French loan-

words in Swedish. 1-6], Studier i modern språkvetenskap 2: 53-72; 9: 3-55; 10: 

81-111; 12: 97-101; 14: 1-17; 15: 9-25. 

 

e) less well-known journals 

 

The place of publication may be provided in less well-known journals: 

 

Sperber, Hans. 1912. “Über den Einfluß sexueller Momente auf Entstehung und 

Entwicklung der Sprache”, Imago. Zeitschrift für Anwendung der Psychoanalyse 

auf die Geisteswissenchaften (Leipzig) 1: 405-453. 

 

 

17.6. Articles in periodicals (i.e. newspapers, magazines) [Newspaper Article, Magazine 

Article ] 
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Tannen, Deborah. 2004. “Being president means never having to say he’s sorry”, The 

New York Times, 12 Oct. 2004: A25. 

 

(The date of the issue / edition should be formatted like dates of online access, cf. (16.13 

c).) 

 

For a magazine article, either the issue date or the volume and issue number should be 

given (and consistency retained in the References list). Compare: 

 

Stern, Marlow. 2011. “Revenge of the nerds”, Newsweek 158, 7: 58-59. 

Stern, Marlow. 2011. “Revenge of the nerds”, Newsweek, 5 Aug. 2011: 58-59. 

 

This convention covers paginated articles in printed form. For articles (also) published in 

Internet periodicals, see section (17.22). 

 

17.7. Articles in edited collections [Book Section ] 

 

Entries should contain the following elements:  

 

(First) author’s surname, first name(s).  

Year of publication.  

“Full title (and subtitle) of the work”, in: 

First name(s) and surname of the editor (ed.), 

Full title (and subtitle) of the work.  

(Edition.)  

(Volume or part number).  

(Series title.)  

Place of publication:  

Publisher, 

Page numbers. 
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Article titles are enclosed within double quotation marks, followed by “in” (in lowercase), 

a colon, the name(s) of the editor(s) of the collection, the title of the collection, additional 

information (i.e. edition, volume or series title), place of publication and publisher, and 

finally the page numbers.  

Note that while only the name of the author appears in the in-text citation, both 

the author and editor are given in the References. 

Edited collections from which only specific authored articles have been cited need 

not be listed separately in the final References.  

 

Arnaud, Pierre J., Emmanuel Ferragne, Diana M. Lewis and François Maniez. 2008. 

“Adjective + noun sequences in attributive or NP-final positions: Observations 

on lexicalization”, in: Sylviane Granger and Fanny Meunier (eds.), Phraseology: 

An interdisciplinary perspective. Amsterdam: John Benjamins, 111-125. 

Corbett, Greville G. and Norman M. Fraser. 2000. “Gender assignment: A typology and 

a model”, in: Gunter Senft (ed.), Systems of nominal classification. (Language, 

Culture and Cognition 4.) Cambridge: Cambridge University Press, 293-325. 

Mańczak-Wohlfeld, Elżbieta. 2002. “Polish”, in: Manfred Görlach (ed.), English in Eu-

rope. Oxford: Oxford University Press, 213-228. 

Rissanen, Matti. 1999. “Syntax”, in: Roger Lass (ed.), Cambridge history of the English 

language. Vol. 3. Cambridge: Cambridge University Press, 187-331. 

Storey, John. 2006. “Introduction”, in: John Storey (ed.), Cultural theory and popular 

culture: A reader. (3rd edition.) Harlow: Pearson Education, 273-277. 

 

Note that series titles are given in a roman font type (not italicized) and capitalized like 

a proper name. 

 

17.8. Short stories or poems [Book Section not Edited ] 

 

Mansfield, Katherine. [1820] 1962a. “Bliss”, in: Katherine Mansfield, Bliss and other 

stories. Harmondsworth: Penguin Books, 95-110. 

Mansfield, Katherine. [1820] 1962b. “The escape”, in: Katherine Mansfield, Bliss and 

other stories. Harmondsworth: Penguin Books, 212-219. 
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Szymborska, Wisława. 2004. “Konkurs piękności męskiej” [Bodybuilders’ contest], in: 

Wisława Szymborska, Wiersze wybrane [Selected poems]. Kraków: Wydawnic-

two a5, 91. 

 

17.9. Entries in encyclopedias (in printed form and in electronic form) [Encyclopedia 

Article ] 

 

Sapir, Edward. 1929. “Central and North American languages”, in: Encyclopaedia Bri-

tannica. Vol. 5 (14th edition.) London: Encyclopaedia Britannica Company, 

138-141. 

 

(Notes: This format pertains to articles published in traditionally paginated encyclope-

dias; for web-based encyclopedias, turn to (17.22 g). In anonymous articles the title ap-

pears first, i.e. before the year; on the formatting of such anonymous entries in (online) 

encyclopedias, see (17.22 g)). 

 

(EndNote users: Anonymous dictionary and encyclopedia entries listed in the References 

cannot be formatted fully automatically. Refer to the guides on the WA Stylesheet & 

Template Support site on Moodle for more information.) 

 

 

17.10. Preface, introduction, afterword, etc. [Book Section ] 

 

Görlach, Manfred. 2002. “Introduction”, in: Manfred Görlach (ed.), English in Europe. 

Oxford: Oxford University Press, 1-12. 

 

17.11. Reviews and book notices published in edited collections, journals, periodicals 

[Review, Book Notice ] 

 

Reviews appear without double quotation marks; the reviewed publication is given in a 

separate entry. 
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Adamska-Sałaciak, Arleta. 1996. Review of Mikołaj Kruszewski: Writings in general 

linguistics edited by E. F. K. Koerner, Folia Linguistica Historica XVII, 1-2: 

211-216. 

Crystal, David. 1995. Review of Talking proper by Lynda Mugglestone, Times Higher 

Education Supplement, 7 July 1995: 19. 

Kaye, Alan S. 2003. Book notice of A dictionary of European anglicisms edited by 

Manfred Görlach, Language 79, 2: 654-655. 

 

17.12. Review articles [Review Article with Title, Review Article without Title 

] 

 

(Note: Titles reviewed need not be placed separately in the References list, unless they 

are also cited independently.) 

 

a) with a title 

 

Kilarski, Marcin. 1999. “On ‘linguistic male nipples’” (Review article of Sprache – Ge-

nus/Sexus edited by Heinz Sieburg), Poznań Studies in Contemporary Linguis-

tics 35: 165-173. 

 

b) without a title 

 

Kryk-Kastovsky, Barbara. 2001. Review article of Diachronic pragmatics by Leslie K. 

Arnovick, Poznań Studies in Contemporary Linguistics 37: 211-220. 

 

17.13. Replies, rejoinders [Journal Article ] 

 

Honey, John. 1997. Language is power: The story of Standard English and its enemies. 

London: Faber & Faber. 

Honey, John. 2000. “A response to Trudgill’s review of Language is power”, Journal of 

Sociolinguistics 4, 2: 316-319. 

Trudgill, Peter. 1998. Review of Language is power: The story of Standard English and 

its enemies by John Honey, Journal of Sociolinguistics 2, 3: 457-461. 
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(The relevant example above is Honey (2000).) 

 

17.14. Obituaries 

 

Titles of obituaries appear without italics or quotation marks. 

 

Stockwell, Robert P. 1993. Obituary of Dwight L. Bolinger, Language 69: 99-112. 

 

17.15. Publications in press [Book, Journal Article, etc. ] 

 

References that are in press should be updated when published. Only those publications 

may be listed that have actually been accepted for publication by a publisher. Otherwise, 

they should be listed as unpublished (17.16) or as in preparation (17.17); the term forth-

coming should not be used. 

 

Goodovsky, Dob. In press. My personal linguistics. Tiptown: Hopex. 

 

(EndNote users: Works in press cannot be formatted fully automatically in the lists of 

references. Refer to the guides on the WA Stylesheet & Template Support site on Moodle 

for more information.) 

 

17.16. Works in preparation [Unpublished Work ] 

 

Titles of works in preparation appear without italics or quotation marks. 
 

Becker, Gabriele. In preparation. The future of language. 

 

(EndNote users: Works in preparation cannot be formatted fully automatically in the Ref-

erences. Refer to the guides on the WA Stylesheet & Template Support site on Moodle 

for more information.) 

 

17.17. Unpublished dissertations, theses, manuscripts [Thesis, Manuscript ] 
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Titles of unpublished theses or manuscripts appear without italics or quotation marks. 

The type of work and the institution (where applicable) are given in square brackets.  

 

Eisikovits, Edina. 1981. Inner-Sydney English: An investigation of grammatical varia-

tion in adolescent speech. [Unpublished Ph.D. dissertation, University of Syd-

ney.]. 

Golston, Chris. 1995. Against syllabification. [Unpublished ms, California State Uni-

versity, Fresno, CA.]. 

Klimaszyk, Aleksandra. 2003. The phenomenon of political correctness and its repre-

sentation in learner’s dictionaries. [Unpublished MA thesis, Adam Mickiewicz 

University, Poznań.]. 

Ryfa, Joanna. 2003. Estuary English: A controversial issue? [Unpublished post-graduate 

diploma paper, Adam Mickiewicz University, Poznań.]. 

Tallhage, Eva. 1991. Lånorden i svenska, danska och norska under efterkrigstiden: En 

jämförande studie [Loanwords in Swedish, Danish and Norwegian after World 

War II: A comparative study]. [Unpublished seminar paper, University of Stock-

holm, Department of Nordic Languages.]. 

 

17.18. Papers presented at conferences; lectures, addresses [Conference Paper, Talk 

] 

 

Such references may be given if the conference paper has not (yet) been published. If the 

paper has been published, it should be listed as a regular publication.  

 

a) conference papers 

 

Meyerhoff, Miriam. 2004. Agency and affect: Reduced responsibility as a gendered 

stance in apologising. (Paper presented at the 35th Poznań Linguistic Meeting, 

18-20 May 2004.). 

 

b) talks 

 



WA Stylesheet 1.5.2 (Updated: 28 March 2022) 56 

Linne, Vera. 2004. Linguistics for the dummies. (Lecture given at the School of Educa-

tion, New York, 23 May 2004.). 

 

When the author specifically wishes to refer to the conference version of the paper rather 

than the published version, the information about the publication should still be provided. 

 

17.19. Reprints [Book, Journal Article ] 

 

a) books 

 

When using the original publication we give the original date, with information about the 

reprint given in square brackets: 

 

Codrington, R[obert] H[enry]. 1885. The Melanesian languages. Oxford: Oxford Uni-

versity Press. [Reprinted, 1974, Amsterdam: Philo Press.]. 

  

When using a reprint we give the original date in square brackets, followed by the date of 

the reprint, with full information about the original publication given in square brackets 

(with the original publication year also repeated optionally): 

 

Arnauld, Antoine and Claude Lancelot. [1660] 1975. General and rational grammar: 

The Port-Royal Grammar. (Edited and translated by Jacques Rieux and Bernard 

E. Rollin.) The Hague: Mouton. [Originally published, Paris: Pierre Le Petit.]. 

 

or: 

 

Arnauld, Antoine and Claude Lancelot. [1660] 1975. General and rational grammar: 

The Port-Royal Grammar. (Edited and translated by Jacques Rieux and Bernard 

E. Rollin.) The Hague: Mouton. [Originally published, 1660, Paris: Pierre Le 

Petit.]. 

 

b) articles 
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When we cite original texts for which we wish to add information about the available 

reprint edition (usually the case with journal articles reprinted in edited collections), the 

date and all the remaining information about the reprint is given in square brackets at the 

end of the reference, e.g.: 

 

Jakobson, Roman. 1936. “Beitrag zur allgemeinen Kasuslehre”, Travaux de Cercle Lin-

guistique de Prague 6: 240-288. [Reprinted in: Roman Jakobson, 1971, Selected 

writings II: Word and language. The Hague: Mouton, 23-71.]. 

Trudgill, Peter. 1988. “Norwich revisited: Recent linguistic changes in an English urban 

dialect”, English World-Wide 9: 33-49. [Reprinted in: Martin Pütz (ed.), 1992, 

Thirty years of linguistic evolution. Amsterdam: John Benjamins, 361-377.]. 

 

When the source text used for citing is the reprinted chapter rather than the original article, 

notation should be as follows: 

 

Jakobson, Roman. [1936] 1971. “Beitrag zur allgemeinen Kasuslehre”, in: Roman Jak-

obson, Selected writings II: Word and language. The Hague: Mouton, 23-71. 

[Originally published, Travaux de Cercle Linguistique de Prague 6: 240-288.]. 

Trudgill, Peter. [1988] 1992. “Norwich revisited: Recent linguistic changes in an Eng-

lish urban dialect”, in: Martin Pütz (ed.), Thirty years of linguistic evolution. 

Amsterdam: John Benjamins, 361-377. [Originally published, English World-

Wide 9: 33-49.]. 

 

c) other reprints 

 

Books and other works published separately, reprinted in edited collections: 

 

When citing the original: 

 

Humboldt, Wilhelm von. 1827. Brief an M. Abel-Rémusat über die Natur gramma-

tischer Formen im allgemeinen und über den Geist der chinesischen Sprache im 

besonderen. Paris: Dondey-Dupré. [Reprinted in: Christoph Harbsmeier (ed.), 
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1979, Wilhelm von Humboldts Brief an Abel Rémusat und die philosophische 

Grammatik des Altchinesischen. Stuttgart: Fromman, 17-88.]. 

 

When citing the reprint: 

 

Humboldt, Wilhelm von. [1827] 1979. “Brief an M. Abel-Rémusat über die Natur 

grammatischer Formen im allgemeinen und über den Geist der chinesischen 

Sprache im besonderen”, in: Christoph Harbsmeier, Wilhelm von Humboldts 

Brief an Abel Rémusat und die philosophische Grammatik des Altchinesischen. 

Stuttgart: Friedrich Frommann, 17-88. [Originally published, Paris: Dondey-

Dupré.]. 

 

17.20. Publications in electronic form (corpora, dictionaries, encyclopedias) [Electronic 

Book, Edited Electronic Book ] 

 

British National Corpus: World Edition [BNC-WE]. 2000. (2 CD-ROMs.) Oxford: Ox-

ford University Computing Services. 

Fisiak, Jacek (ed.). 2003. The new Kosciuszko Foundation dictionary on CD-ROM: 

English-Polish, Polish-English. Kraków: Universitas. 

Oxford English Dictionary on CD-ROM. 1992. (2nd edition.) Oxford: Oxford Univer-

sity Press. 

 

EndNote Users: (Earlier) printed editions of dictionaries are given as regular (Edited) 

Books (cf. 17.3). 

 

17.21. Software [Computer Program ] 

 

ID Software. 1993. The Ultimate Doom. New York: GT Interactive Software. 

Scott, Mike. 2011. WordSmith Tools. Version 5.0. Oxford: Oxford University Press. 

(http://www.lexically.net/wordsmith/) (date of access: 1 Oct. 2011). 

SIL International. 2011. Doulos SIL. Dallas: SIL International. 

(http://scripts.sil.org/FontDownloadsDoulos) (date of access: 1 Oct. 2011). 
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Note that the names of computer programs follow the original capitalization format. Any 

URL given should be the official author’s web address containing information, and pos-

sibly download options, for the program. 

 

17.22. Internet sources 

 

Entries should contain the following elements (optional elements are here given in paren-

theses):  

 

(First) author’s surname, first name(s).  

Year of Internet publication or the year from the date of access if no date of publication 

is given.  

Title of the document.  

(URL) 

(Date of access). 

 

The URL of the publication should be given without a hyperlink (i.e. it should not be 

underlined). Links should be given to publicly available authorized and complete texts 

and materials, not to pre-publication versions of articles (not intended for citing), illegally 

or privately stored files, articles or books found in paid online subscription databases 

(Questia, ScienceDirect, ProQuest etc.), or online sample book viewers (Google Books, 

Amazon etc.). Note that some Internet-only sources may require special citing conven-

tions, as described in section 9.16. 

 

a) previously published books or articles which are available online [Book, Book Sec-

tion ] 

 

The information about the print publication should also be provided. 

 

Labov, William. 1998. “Coexistent systems in African-American English”, in: Salikoko 

S. Mufwene, John R. Rickford, Guy Bailey and John Baugh (eds.), The structure 

of African-American English. London: Routledge, 110-153. (http://www.ling.up-

enn.edu/~wlabov/Papers/CSAA.html) (date of access: 15 Jan. 2005). 
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Mencken, Henry Louis. 1921. The American language: An inquiry into the development 

of English in the United States. (2nd edition.) New York: A.A. Knopf. 

(http://www.bartleby.com/185) (date of access: 15 Jan. 2005). 

 

b) e-books [Electronic Book ] 

 

In the case of e-book publications released with printed page numbers (e.g. in the pdf 

format), the standard notation for books applies, e.g.: 

 

Bayard, Pierre. 2007. How to talk about books you haven't read. (Translated by Jeffrey 

Mehlman.) New York: Bloomsbury. 

 

The URL of the online bookshop or vendor from which the e-book has been purchased 

should not be included. If the e-book is distributed freely by the publisher, the URL can 

be provided. 

The e-publication type should be indicated if it does not reproduce the (original) 

printed paging format (e.g. “locations” in the case of Kindle e-books, cf. 9.16 c), e.g.: 

 

Northedge, Andrew. 2005. The good study guide. (Kindle edition.) Walton Hall, Milton 

Keynes, UK: The Open University. 

 

c) books or articles in press which are available online [Book, Book Section, Journal 

Article ] 

 

The information about the print publication should also be provided. 

 

Corbett, Greville G. In press. “Agreement: Terms and boundaries”, in: William Griffin 

(ed.), “The role of agreement in natural language”: Proceedings of the 2001 

Texas Linguistic Society Conference, Austin, Texas, 2-4 March 2001. Austin: 

Texas Linguistic Forum. (http://www3.surrey.ac.uk/LIS/SMG/projects/agree-

ment/Papers/texas.pdf) (date of access: 15 Jan. 2005). 

 

(Publications in press should be updated as soon as possible, cf. 17.15.) 
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(EndNote users: Entries in press cannot be formatted fully automatically in the Refer-

ences. Refer to the guides on the WA Stylesheet & Template Support site on Moodle for 

more information.) 

 

d) articles in Internet journals [Journal Article, Electronic Article ] 

 

Percy, Carol. 2001. “The social symbolism of contractions and colloquialisms in con-

temporary accounts of Dr. Samuel Johnson: Bozzy, Piozzi, and the authority of 

intimacy”, Historical Sociolinguistics and Sociohistorical Linguistics 2. 

(http://www.let.leidenuniv.nl/hsl_shl/bozzy,%20piozzi1.htm) (date of access: 15 

Jan. 2005). 

Rodino, Michelle. 1997. “Breaking out of binaries: Reconceptualizing gender and its re-

lationship to language in computer-mediated communication”, Journal of Com-

puter-Mediated Communication 3, 3. (http://www.ascusc.org/jcmc/vol3/is-

sue3/rodino.html) (date of access: 15 Jan. 2005). 

 

Some freely distributed specialist journals identify themselves using a standardized DOI 

number (“digital object identifier”, http://www.doi.org), rather than a (changeable) URL 

address. When listing articles from such journals, the persistent doi address should be 

given in parentheses at the end of the reference (and the doi number itself might be used 

for the page range in some cases). The date of access is irrelevant with persistent doi 

addresses and need not be given. For example: 

 

Spotorno, Nicola, Anne Cheylus, Jean-Baptiste Van der Henst and Ira A. Noveck. 2013. 

“What’s behind a P600? Integration operations during irony processing”, PLoS 

ONE 8, 6: e66839. (doi:10.1371/journal.pone.0066839). 

 

e) articles in Internet magazines and newspapers [Newspaper Article, Magazine Arti-

cle ] 

 

http://www.doi.org/


WA Stylesheet 1.5.2 (Updated: 28 March 2022) 62 

Fuller, Thomas. 2005. “An American accent as professional liability”, The International 

Herald Tribune, 9 Feb. 2005. (http://www.iht.com/articles/2005/02/09/news/let-

ter.html) (date of access: 8 Mar. 2005). 

“Hillary Rodham Clinton”. 2011. The New York Times, 14 Jan. 2011. (http://topics.ny-

times.com/top/reference/timestopics/people/c/hillary_rodham_clinton/in-

dex.html?inline=nyt-per) (date of access: 14 Feb. 2011). 

Power, Carla. 2005. “Not the Queen’s English”, Newsweek, 7 Mar. 2005. 

(http://www.msnbc.msn.com/id/7038031/site/newsweek) (date of access: 8 Mar. 

2005). 

 

(Note: The date of the issue / edition should be formatted in abbreviated form, as given 

in 16.13 c) 

 

f) online dictionaries, encyclopedias, corpora and concordancers [Online Database 

]  

 

British National Corpus. 2010. Oxford: Oxford University Press. 

(http://sara.natcorp.ox.ac.uk) (date of access: 14 Oct. 2011). 

Dryer, Matthew S. and Martin Haspelmath (eds.). 2011. The world atlas of language 

structures online. Munich: Max Planck Digital Library. (http://wals.info) (date 

of access: 14 Oct. 2011). 

OED Online. 2011. Oxford: Oxford University Press. (http://www.oed.com) (date of ac-

cess: 14 Oct. 2011). 

WebCorp Live. 2011. Birmingham: Birmingham City University. (http://www.web-

corp.org.uk/live/) (date of access: 14 Oct. 2011). 

 

EndNote Users: (Earlier) printed editions of atlases and encyclopedias are given as regu-

lar (Edited) Books (cf. 17.3). 

 

g) entries in online encyclopedias, dictionaries [Entry in Online Database ] 

 

Maddieson, Ian. 2011. “Consonant inventories”, in: Matthew S. Dryer and Martin 

Haspelmath (eds.), The world atlas of language structures online. Munich: Max 
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Planck Digital Library, Chapter 1. (http://wals.info/chapter/1) (date of access: 14 

Oct. 2011). 

 

In anonymous articles the title appears first, i.e. before the year. Note also the capitalized 

“In:”: 

 

“Concordancer”. 2011. In: Wikipedia: The Free Encyclopedia. (http://en.wikipe-

dia.org/wiki/Concordancer) (date of access: 14 Oct. 2011). 

“factual, adj.”. 2011. In: OED Online. Oxford: Oxford University Press. 

(http://www.oed.com/view/Entry/67528?redirectedFrom=factual) (date of ac-

cess: 14 Oct. 2011). 

“Hillary Rodham Clinton”. 2011. In: Encyclopaedia Britannica. (http://www.britan-

nica.com/EBchecked/topic/121809/Hillary-Rodham-Clinton) (date of access: 20 

Feb. 2011). 

 

 

(EndNote users: Anonymous dictionary and encyclopedia entries listed in the References 

cannot be formatted fully automatically. Refer to the guides on the WA Stylesheet & 

Template Support site on Moodle for more information.) 

 

h) professional web sites (societies, associations, etc.) [Web Site ] 

 

The James Joyce Society. 2011. The James Joyce Society Home Page. 

(http://www.joycesociety.org) (date of access: 1 Oct. 2011). 

 

Note: Names of organizations are capitalized like proper names. Titles of their web sites 

(but not of individual web pages) are retained as-is and not collapsed to the “as-in-a-

sentence” format.  

 

i) course materials [Web Page ] 

 

McGillivray, Murray. 2007. Old English at the University of Calgary. (http://www.ucal-

gary.ca/UofC/eduweb/engl401) (date of access: 15 Feb. 2007). 
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j) other texts (draft versions of papers/books, students’ papers) [Web Page ] 

 

Corbett, Greville G. 2000a. Agreement in the Slavonic languages: A provisional bibli-

ography. (http://www.surrey.ac.uk/LIS/SMG/agr.html) (date of access: 15 May 

2001). 

 

k) personal pages [Web Page ] 

 

Veselinova, Ljuba. 2003. Home page. (http://www.ling.su.se/staff/ljuba) (date of access: 

8 Mar. 2005). 

 

l) messages posted to a discussion forum or an electronic mailing list [Forum Post 

] 

 

Pullum, Geoff. 2011. Remarks by Noam Chomsky in London (Forum post, 19 Nov. 

2011). The LINGUIST List. (http://linguistlist.org/issues/22/22-4631.html) (date 

of access: 8 Dec. 2011). 

 

Titles of forums (but not of individual posts) are retained as on the web site and not con-

verted to the “as-in-a-sentence” format. 

 

m) microblog posts [Microblog Post ] 

 

Barack Obama [= Obama, Barack]. 2009. Humbled. http://my.baracko-

bama.com/page/community/post/obamaforamerica/gGM45m. (Facebook update, 

9 Oct. 2009). (http://www.face-

book.com/posted.php?id=6815841748&share_id=154954250775&com-

ments=1#s154954250775) (date of access: 1 Nov. 2011). 

@mike_matas [= Matas, Mike]. 2011. Kayaking on Lake Tahoe http://twit-

pic.com/6jko0s. (Twitter post, 11 Sep. 2011). (http://twit-

ter.com/#!/mike_matas/status/112994840609964032) (date of access: 1 Nov. 

2011). 
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n) blog posts [Blog Post ] 

 

Zwicky, Arnold. 2011. Ice cream, fireworks, smiles, and more. (Blog post, 10 Aug. 

2011). Language Log. (http://languagelog.ldc.upenn.edu/nll/?p=3354) (date of 

access: 1 Nov. 2011). 

 

Titles of blogs (but not of individual entries) are retained as on the web site and not con-

verted to the “as-in-a-sentence” format. 

 

o) podcasts [Podcast ] 

 

Trudgill, Peter. 2010. “Social structure and language change”, in: The Shaping of Lan-

guage. (iTunes U podcast, 22 July 2010). Melbourne: La Trobe University. 

(http://itunes.apple.com/au/itunes-u/the-shaping-of-language/id391930814) (date 

of access: 23 Mar. 2012). 

Wernicke, Sebastian. 2010. “Lies, damned lies and statistics (about TEDTalks)”. 

(TEDtalk video, Apr. 2010). 

(http://www.ted.com/talks/lies_damned_lies_and_statistics_about_tedtalks.html) 

(date of access: 23 Mar. 2012). 

 

Note that titles of series or channels, if applicable, are capitalized as given on the web 

site. 

 

p) online videos [Online Multimedia ] 

 

“Break up over Texas”. 2012. In: Mayday. (YouTube clip, 28 Jan. 2012). 

(https://www.youtube.com/watch?v=2G_h76s7pe8) (date of access: 1 Apr. 

2012). 

 

Note that titles of series, if applicable, are capitalized as in the original. 
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(EndNote users: Anonymous entries cannot be formatted fully automatically. Refer to the 

guides on the WA Stylesheet & Template Support site on Moodle for more information.) 

 

17.23. Films, TV and radio programs [Film or Broadcast ]  

 

Spielberg, Steven (dir.). 1993. Schindler’s list. Universal. 

 

17.24. Song lyrics [Audiovisual Material ] 

 

Porter, Cole Albert. 1998. “What is this thing called love”, Back to Earth. (Performed 

by Lisa Ekdahl and the Peter Nordahl Trio.) BMG. 

Springsteen, Bruce. 2002. “Empty sky”, The Rising. Columbia. 
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17.25. Works of art [Artwork ] 

 

Bomberg, David. 1914. The Mud Bath. (Oil on canvas, 152 x 224 cm.) London: Tate 

(http://www.tate.org.uk/servlet/ViewWork?workid=1238) (date of access: 22 

Feb. 2012). 

Gaudier-Brzeska, Henri. 1914. Hieratic Head of Ezra Pound. (Pentelic marble, 91.4 x 

61 cm.) Washington, D.C.: National Gallery of Art. 
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